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chapter 1

Introduction to Pro Tools with Avid Video
This guide describes the use of Avid Mojo® SDI, 
AVoption|V10™, and Avid Mojo® peripherals 
(referred to here as Avid video peripherals) with 
Pro Tools|HD® and Pro Tools LE® systems. 

Pro Tools® and Avid video peripherals combine 
the powerful audio post-production features of 
Pro Tools with integrated support for capture, 
import, and playback of Avid video media.

Capabilities of Pro Tools with Avid 
Peripherals

Pro Tools with Avid video peripherals lets you:

• Import, play back, and edit Avid video on 
the Pro Tools video track with near sample-
accurate precision against audio tracks

• Digitize video to the Pro Tools Timeline 
(Pro Tools HD only)

• View Avid video edits on the video track

• Play QuickTime movies and Avid video on 
an external monitor

• Import mixed video resolutions to the 
video track

• Import and play back true 24P and 25P 
(Progressive Scan) picture media created in 
Avid video workstations
DigiTranslator 2.0 Integrated 
Option
Use DigiTranslator to convert AAF and OMFI se-
quences into Pro Tools session files. You can 
also use it to export audio material from 
Pro Tools sessions to AAF sequences or OMFI se-
quences and files for import into other systems.

MachineControl
You can use Digidesign®’s MachineControl soft-
ware to remotely control your external audio 
and video decks from Pro Tools. MachineCon-
trol is a Pro Tools software option that can be 
purchased separately.

Pro Tools also supports many features that 
apply both to QuickTime movies and Avid 
video. See the Pro Tools Reference Guide for 
detailed information on working with video 
in Pro Tools.

DigiTranslator 2.0 is included with AVop-
tion|V10 and may be purchased separately 
for Avid Mojo SDI and Avid Mojo users. For 
more information, refer to the DigiTransla-
tor 2.0 Integrated Option Guide.

For more information, see the MachineCon-
trol Guide.
Chapter 1: Introduction to Pro Tools with Avid Video 1
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Support for Avid Unity ISIS 
and MediaNetwork Storage 
Systems
Pro Tools with an Avid video peripheral sup-
ports Avid Unity™ ISIS and Unity MediaNet-
work high-speed network storage systems, 
which let multiple users store and share media 
through a gigabit Ethernet connection (for ISIS) 
or fibre channel connection (for MediaNet-
work).

Users of Pro Tools, Media Station|PT, and other 
Avid applications can use a Unity system to 
share the same media as follows:

• Push/pull audio and video media.

• Stream audio and video media in real time 
(Windows XP only).

• Configure up to nine Pro Tools or 
Media Station|PT users on the same ISIS or 
MediaNetwork workgroup.

• Share AAF, OMF, and MXF audio and video se-
quences (DigiTranslator required).

• Share AAF, OMF, and MXF sequences using 
the Avid Interplay asset management system 
(Avid Interplay system required).

For detailed information on configuring your 
Pro Tools system with an Avid video peripheral 
as an Avid Unity ISIS or Unity MediaNetwork 
client, see the Pro Tools Unity ISIS Guide and the 
Pro Tools Unity MediaNetwork Guide. Also, refer to 
the Digidesign website (www.digidesign.com), 
as well as the Avid Unity ISIS or Unity Medi-
aNetwork documentation.
Avid Video Peripherals Guide
System Requirements
The system requirements for Pro Tools with an 
Avid video peripheral are as follows:

• One of the following:

• A Digidesign-qualified Pro Tools|HD sys-
tem with a 96 I/O, 192 I/O, or 
192 Digital I/O

– or –

• A Digidesign-qualified Pro Tools LE system 
with a 003, 003 Rack, Digi 002, 
Digi 002 Rack, Mbox 2, Mbox 2 Pro, or 
Mbox 2 Mini

• Separate drives for audio and video media

• SYNC HD or SYNC I/O (required only for 
Pro Tools HD)

• Black burst generator or tri-level sync genera-
tor (required only for Pro Tools HD)

Compatibility Information

Digidesign can only assure compatibility and 
provide support for hardware and software it has 
tested and approved. 

For a list of Digidesign-qualified computers, op-
erating systems, hard drives, and third-party de-
vices, as well as information about specific ver-
sions of ATTO and nVidia software, refer to the 
support pages at the Digidesign website 
(www.digidesign.com).



Digidesign Registration for 
AVoption|V10
Review the enclosed Digidesign Registration In-
formation Card and follow the instructions on it 
to quickly register your purchase online. Regis-
tering your purchase is the only way you can be 
eligible to receive complimentary technical sup-
port and future upgrade offers. It is one of the 
most important steps you can take as a new user.

See your Avid documentation for instructions 
on registering your Avid Mojo SDI or 
Avid Mojo.
Conventions Used in This 
Guide
All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:
:

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control 
key and press the N key

Control-click Hold down the Control 
key and click the mouse 
button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide or other Pro Tools Guides.
Chapter 1: Introduction to Pro Tools with Avid Video 3
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About the Pro Tools Guides
In addition to the printed guides that came with 
your system, PDF versions of the Pro Tools 
guides are installed automatically with 
Pro Tools. To view or print the PDF guides, you 
can use Adobe Reader or Apple Preview.

About www.digidesign.com
The Digidesign website (www.digidesign.com) is 
your best online source for information to help 
you get the most out of your Pro Tools system. 
The following are just a few of the services and 
features available. 

Registration Register your AVoption|V10 online. 
See the enclosed registration form for instruc-
tions. 

Support Contact Digidesign Technical Support 
or Customer Service; download software up-
dates and the latest online manuals; browse the 
compatibility information for system require-
ments; search the online Answerbase or join the 
worldwide Pro Tools community on the Digide-
sign User Conference. 

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from 
Digidesign or sign up for a Pro Tools demo.

To learn more about these and other resources 
available from Digidesign, visit the Digidesign 
website (www.digidesign.com). 
Avid Video Peripherals Guide
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Avid Video Peripherals Hardware Overview
Supported Video Resolutions
Pro Tools with Avid Mojo SDI and Avid Mojo 
(Windows XP and Mac OS X) or AVoption|V10 
(Windows XP only) supports the import and 
playback of all non-HD video resolutions and 
codecs supported by Avid video editing applica-
tions, including the following:

• All standard-definition Avid OMF and MXF 
video files

• Avid IMX MPEG50, MPEG40, MPEG30, and 
OP1a files

The oldest class of ABVB files (ABVB 
“MFM” files) are not supported in 
Pro Tools. These files were created with ver-
sions of Media Composer lower than 7.0, 
and do not have the .omf extension.
• DV50, DV25 and DVC Pro 25 resolutions 
compressed with the Avid codec, including:

• DV25 411: DV25 interlaced scan at 4:1:1 
sampling (for NTSC 30i and PAL 25i 
projects)

• DV25 420: DV25 interlaced scan at 4:2:0 
sampling (for PAL 25i projects)

• DV25p 411: DV25 progressive scan at 4:1:1 
sampling (for NTSC 23.976p and NTSC 24p 
projects)

• DV25p 420: DV25 progressive scan at 4:2:0 
sampling (for PAL 25p and PAL 24p 
projects)

• All standard-definition Avid Multi-Cam 
Resolution files (see “Avid Multi-Cam Reso-
lution Files” on page 30.)

• The following video resolutions created with 
the Avid DV, JFIF or MXF video codecs:

• 1:1 (Uncompressed JFIF/MXF)

• DV50

• DV25 4:1:1 

• DV25 4:2:0

• DV25P 4:1:1

• DV25P 4:2:0

• 15:1s 4:2:2

• 14:1P 4:2:2

• 28:1P 4:2:2 

• 35:1P 4:2:2 
Chapter 2: Avid Video Peripherals Hardware Overview 5
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Playback of QuickTime Movies 
through Avid Video Peripherals

Pro Tools lets you play most standard-definition 
or high-definition QuickTime movies through 
an Avid video peripheral to an external monitor. 

Digidesign has specifically tested DV25 and 
H.264 movies. Other codecs may work but have 
not been tested. (“Uncompressed” QuickTime 
movies are known to play back poorly.) In gen-
eral, performance varies depending on the 
movie dimensions and compression rates, the 
number of tracks, plug-ins and automation in 
your session, and the speed of your processor.

When playing back QuickTime movies through 
Avid video peripherals, the following limita-
tions may apply:

• Playing QuickTime video through any 
FireWire peripheral, including an Avid video 
peripheral, delays the output. You can com-
pensate for this with the QuickTime Video 
Offset setting (located in the Set Video Sync 
Offset dialog). The best setting depends on 
your specific system, but when using Avid 
video peripherals 18 quarter frames is a good 
starting point. See “Compensating for Video 
Monitoring Delays” on page 36 for details.

• Large-dimension movies (such as 1080i) may 
affect processor speed, so you may want to 
work with movies of smaller dimensions.

• Avid video peripherals output only standard-
definition images with a 4:3 aspect ratio. 
When playing back files with different aspect 
ratios (such as 16:9), the image will be 
stretched to 4:3. Some professional monitors 
can compensate for this by letterboxing the 
image.
Avid Video Peripherals Guide
• For best performance when playing Quick-
Time movies through an Avid Mojo, use an 
i-frame codec with a resolution that matches 
your output format. For example, DV NTSC at 
720x480 or DV PAL at 720x576 offers best 
playback performance.

• Avid video peripherals accept only video refer-
ence input at standard definition rates (25 and 
29.97 fps). When playing back QuickTime 
movies with higher frame rates, only every 
other frame will output to the NTSC/PAL 
monitor.

• When playing back movies with frame rates of 
50, 59.94, or 60 fps, set the Pro Tools session 
rate to one half of the movie's frame rate.

Support for Mixed Video 
Resolutions

Avid video peripherals support video files of 
mixed resolutions and codecs in the video track. 
For example, the video track can contain DV25 
and 15:1s files. However, all files must be Avid 
files of the same frame rate. Mixed files with dif-
ferent frame rates are not supported. Mixing 
Avid video and QuickTime movies in the same 
Timeline is also supported, but you cannot have 
both on the same video track.



Caveats

The following caveats apply to all supported res-
olutions:

• Pro Tools with Avid video peripherals outputs 
video to NTSC and PAL monitors only. 24 fps 
and 23.97 fps video output is converted to 
NTSC (29.97 fps) or PAL (25 fps) output in Pro 
Tools. 

• Pro Tools video digitizing and playback is in-
tended for monitoring purposes only, and is 
not suitable for professional layback or broad-
cast, regardless of the resolution or frame rate 
of the video clip. 

• Applying a pull-up to video in a session 
may have unpredictable effects on the 
playback of any Avid video in that session. 
Only use video pull-up feature for sessions 
that do not contain Avid video.

• Heavy usage of RTAS plug-ins with Quick-
Time or Avid video may cause video output 
to be erratic or skip frames. If possible, con-
vert RTAS plug-ins to TDM.

• If the quality of the QuickTime image is 
low on Windows XP, ensure that the High-
Quality QuickTime Image option is se-
lected in the Operations page of the Prefer-
ences dialog.
Chapter 2: Avid Video Peripherals Hardware Overview 7



8

AVoption|V10 Interface
The following sections describe the functions of 
the AVoption|V10 breakout box.

AVoption|V10 Front Panel

The front panel of the AVoption|V10 (see 
Figure 1 on page 8) has eleven indicators and a 
power switch. When the AVoption|V10 is pow-
ered on, the indicators turn on and off as it goes 
through a power-on self-test (POST).

The front panel of the AVoption|V10 breakout 
box provides the following LED indicators:

HD (Yellow) Is currently non-functional.

SD (Green) Is currently non-functional.

DV (Yellow) Lights when DV input is selected.
Avid Video Peripherals Guide
NTSC (Yellow) Lights when an NTSC project is 
selected.

PAL (Green) Lights when a PAL project is se-
lected.

Ref (Green) Lights when the AVoption|V10 is 
locked to the incoming Reference signal.

Pull Down (Green) Is currently non-functional. 
For indication of any pull-downs applied by 
Pro Tools, see the indicator light on the SYNC 
I/O.

LTC (Green) Lights when LTC IN is being input 
to AVoption|V10.

44.1 (Yellow) Is currently non-functional.

48 (Green) Is currently non-functional.

96 (Green) Is currently non-functional.
Figure 1.  AVoption|V10 breakout box front panel

Power switch



AVoption|V10 Back Panel 
Figure 2.  AVoption|V10 back panel
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Table 1. Video I/O Identifiers
Number Label Function, Type of Connector, and Usage

1 Video Reference (REF) Black burst or house synchronization input, BNC connector. 
Synchronizes the system with the global clock source pro-
vided by the house sync or black burst generator.

2 COMPONENT Y IN Video Y component input, BNC connector. Connects to ana-
log video output of decks.

3 COMPONENT R-Y IN Video R-Y component input, BNC connector. Connects to 
analog video output of decks.

4 COMPONENT B-Y IN Video B-Y component input, BNC connector. Connects to 
analog video output of decks.

5 COMPOSITE IN Composite video input, BNC connector. Connects to analog 
video output of decks.

6 S-VIDEO IN Super-video input, 4-pin connector. Connects to analog video 
output of decks.

7 S-VIDEO OUT Super-video output, 4-pin connector. Connects to analog 
video input of decks.

8 COMPONENT Y OUT Video Y component (Betacam) output, BNC connector. Con-
nects to analog video input of decks.

9 COMPONENT R-Y OUT Video R-Y component (Betacam) output, BNC connector. Con-
nects to analog video input of decks.
Chapter 2: Avid Video Peripherals Hardware Overview 9
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10 COMPONENT B-Y OUT Video B-Y component (Betacam) output, BNC connector. Con-
nects to analog video input of decks.

11 COMPOSITE OUT 1 Composite video output, BNC connector. Connects to analog 
video input of decks or monitor.

12 COMPOSITE OUT 2 Composite video output, BNC connector. Connects to analog 
video input of decks or monitor.

13 SDI IN Serial digital input, BNC connector. Connects to a serial dig-
ital output from a digital video source.

14 SDI OUT 1 Serial digital output number 1, BNC connector. Connects to 
VTR input, a video monitor, or other serial digital device.

15 SDI OUT 2 Serial digital output number 2, BNC connector. Connects to 
VTR input, a video monitor, or other serial digital device.

16 SDTI IN Not currently used.

17 SDTI OUT Not currently used.

18 1394 Host Connects to any available 1394 (FireWire) port on the CPU.

19 1394 DV Connects to the DV source deck.

20 LTC IN Receives LTC time code.

21 LTC OUT Sends LTC time code out (not used).

22 OPTICAL IN Not currently used.

23 OPTICAL OUT Not currently used.

Table 1. Video I/O Identifiers

Number Label Function, Type of Connector, and Usage
Avid Video Peripherals Guide



Video Connections for 
AVoption|V10

The following video input and output connec-
tions are available with the AVoption|V10:

• Inputs for composite, component (Y, R-Y, 
B-Y), S-Video, DV (1394), and SDI

• Outputs for composite, component (Y, R-Y, 
B-Y), S-Video, DV (1394), and SDI

• Video Ref input to allow the video to be 
locked to an external source such as house 
sync or a black burst generator

All analog video outputs are active during cap-
ture and playback. A video monitor can be con-
nected to any of the following video outputs on 
the AVoption|V10:

• Component

• Composite

• SDI

• S-Video

• DV

Avid Mojo SDI Interface
For detailed information on the Avid Mojo SDI 
interface, see the Using the Avid Mojo SDI Guide.

If you are reading this PDF on a computer with 
an Internet connection, click here to display a 
page in your web browser where you can down-
load this guide.

For more information, visit the Digidesign sup-
port pages at www.digidesign.com/support. 
Synchronization

Setting Up Audio and Video 
Synchronization with Pro Tools HD

Video Synchronization

For accurate capture and playback of video with 
VTRs and other video devices, one of the follow-
ing common video references must be con-
nected to the Reference input of the Avid video 
peripheral:

• Black burst

• House Reference Synchronization source

• Local video source (such as the TBC video 
output of the machine)

Audio Synchronization

To keep audio in sync with video capture and 
playback, the video reference signal must also be 
connected to a SYNC I/O (which in turn is con-
nected to the Pro Tools system). For more infor-
mation on connecting a SYNC HD or SYNC I/O 
to your Pro Tools system, see the SYNC HD 
Guide or the SYNC I/O Guide.

Setting Up Audio and Video 
Synchronization with Pro Tools LE

Synchronizing an Avid Mojo SDI with a 
Pro Tools LE Audio Peripheral

Before synchronizing an Avid Mojo SDI with a 
Pro Tools LE audio peripheral, you must have 
the following:

• Video input/output cable (included with 
the Avid Mojo SDI)

• RCA to BNC adapter (not included with the 
Avid Mojo SDI)
Chapter 2: Avid Video Peripherals Hardware Overview 11
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To synchronize an Avid Mojo SDI with your 
Pro Tools LE audio peripheral:

1  Connect the DVI end of the Avid input/out-
put video cable to the Avid Mojo SDI Video Out-
put port.

2  Connect the RCA to BNC adapter to the black 
Ref/Word Clock BNC cable on the Avid in-
put/output video cable.

3  Connect the RCA cable (which is now con-
nected to the black Ref/Word Clock BNC cable 
via the adapter) to the S/PDIF Input of your 
Pro Tools audio hardware.

4  In Pro Tools, open the Session Setup window 
(Setup > Session) and select S/PDIF from the 
Clock Source pop-up menu.

Synchronizing an Avid Mojo with a 
Pro Tools LE Audio Peripheral

To synchronize an Avid Mojo with your 
Pro Tools LE audio peripheral:

1  Connect one end of an RCA cable to the 
Avid Mojo Audio/Clock Output port.

2  Connect the other end of the RCA cable to the 
S/PDIF Input of your Pro Tools audio hardware.

3  In Pro Tools, open the Session Setup window 
(Setup > Session) and select S/PDIF from the 
Clock Source pop-up menu.
Avid Video Peripherals Guide
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Installing Avid Video Peripherals
This chapter describes hardware and software 
installation for a Pro Tools system with an Avid 
video peripheral.

Upgrading from a Previous 
Version of Pro Tools to 
Pro Tools 7.4
This section describes the steps for installing 
Avid video peripherals if you are upgrading to 
Pro Tools 7.4 from a previous version of 
Pro Tools.

To install Avid video peripherals on a computer 
that is installed with a previous version of 
Pro Tools and Media Station:

1  Do one of the following:

• If you are upgrading from Pro Tools 7.1 or 
Pro Tools 7.2, uninstall Media Station|PT.

– or –

• If you are upgrading from Pro Tools 6.4 and 
Media Station|V10 1.0 or Pro Tools 6.9.x 
and Media Station|PT 1.6.1, uninstall soft-
ware as described in “Uninstalling AVop-
tionDNA, Pro Tools, Media Station, and/or 
Avid Xpress Pro” on page 14.
2  Uninstall the older version of Pro Tools: See 
the Upgrading guide for the version of Pro Tools 
you are uninstalling.

3  On Windows XP, turn off or disconnect the 
Avid video peripheral.

4  Install Pro Tools 7.4: See the Upgrading to 
Pro Tools 7.4 Guide.

5  On Windows XP, connect and/or turn on the 
Avid video peripheral after rebooting. When the 
Found New Hardware Wizard appears, follow 
the steps to automatically find and install the 
driver for the Avid video peripheral.

6  Launch Pro Tools.

7  If the Avid video peripheral firmware needs to 
be updated, the software prompts you. (Follow 
the steps to update the firmware.)

When installing Pro Tools 7.4, make sure 
to select the Avid Video Engine option in the 
installer.
Chapter 3: Installing Avid Video Peripherals 13
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Checking Local Storage and 
ATTO Firmware Before 
Installation
Before installing Avid video peripherals, you can 
do the following:

1  Set up local storage (if necessary): See “Setting 
Up Local Storage” on page 23.

2  Check and update ATTO firmware: See 
“Checking and Updating ATTO Firmware” on 
page 25.

Installing Avid Video 
Peripherals for the First Time
This section describes the steps for installing 
Avid video peripherals if you are installing 
Pro Tools for the first time.

To install Avid video peripherals in this scenario:

1  If installing on Windows XP, disable the 
nVidia Display Driver Service: See “Disabling 
nVidia Display Driver Service” on page 16.

2  Install Pro Tools hardware (if not installed al-
ready): See “Installing Pro Tools Hardware” on 
page 16.

3  Install Pro Tools 7.4: See the Upgrading to 
Pro Tools 7.4 Guide.

4  After rebooting, connect and turn on the Avid 
video peripheral. (If the peripheral was con-
nected during Pro Tools installation on 
Windows XP, you would have been prompted to 
disconnect it.)

When installing Pro Tools 7.4, make sure 
to select the Avid Video Engine option in the 
installer.
Avid Video Peripherals Guide
5  On Windows XP, when the Found New Hard-
ware Wizard appears, follow the steps to auto-
matically find and install the driver for the Avid 
video peripheral.

6  Launch Pro Tools.

7  If the Avid video peripheral firmware needs to 
be updated, the software prompts you. (Follow 
the steps to update the firmware.)

Uninstalling AVoptionDNA, 
Pro Tools, Media Station, 
and/or Avid Xpress Pro
If you are upgrading your Pro Tools system with 
an Avid video peripheral, you must uninstall all 
Pro Tools and Avid-related software before pro-
ceeding.

Uninstalling on Windows XP

To uninstall software:

1  Choose Start > Control Panel.

2  Launch Add or Remove Programs.

3  From the Currently Installed Programs list, 
choose one of the following in any order:

• Digidesign Pro Tools HD

• AVoptionDNA

• Avid Media Station|PT or Avid 
Media Station|V10

• Avid DNADiags

• Avid Log Exchange

• EDL Manager

Older versions of Media Station|PT are in-
compatible with the latest version and must 
be uninstalled as well.



4  Click the Change/Remove button.

5  Follow the on-screen instructions to remove 
the software.

6  Do one of the following:

• If you want to continue uninstalling addi-
tional software after the uninstall is com-
plete, select “No, I will restart my computer 
later” and repeat this procedure until you 
have uninstalled all of the software.

– or –

• If you are finished uninstalling all of the 
software, restart the computer.

Uninstalling on Mac OS X

It is strongly recommended that you uninstall 
software from Mac OS X in the following order:

1  Uninstall Avid Xpress Pro or 
Media Station|PT.

2  Uninstall your previous version of Pro Tools.

Depending on your system configuration, 
you may not have all of these items in-
stalled.

If uninstalling Pro Tools, choose the 
Pro Tools and Device Drivers option when 
prompted.
To uninstall Avid Xpress Pro or Media Station|PT:

1  Insert the installer disc into your computer’s 
CD/DVD drive.

2  Locate and launch the Installer for the soft-
ware you want to uninstall.

3  Click Uninstall.

4  Follow the instructions to remove 
Avid Xpress Pro or Media Station|PT from your 
computer.

5  Restart your computer.

To uninstall Pro Tools from your computer:

1  Make sure you are logged in as an Administra-
tor for the account where Pro Tools is installed. 

2  Go to Applications/Digidesign/Pro Tools/
Pro Tools Utilities and double-click the 
“Uninstall Pro Tools” file.

3  Click Continue to proceed with the uninstall.

4  Choose the type of uninstall you want to per-
form:

Safe Uninstall Leaves certain plug-ins and sys-
tem files needed for compatibility with some 
Avid products.

Clean Uninstall Removes all Pro Tools files, in-
cluding system files, Digidesign plug-ins, and 
MIDI patch names. 

5  Click Uninstall. 

6  Enter your Administrator password and click 
OK. 

7  Click Finish to close the Installer window.

For details on Administrator privileges in 
Mac OS X, refer to your Apple OS X docu-
mentation. 
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Disabling nVidia Display 
Driver Service
(Windows XP Only)

To use Avid video peripherals with Pro Tools|HD 
systems on Windows XP, the nVidia Display 
Driver Service should be disabled. 

To disable nVidia Display Driver Service:

1  Select Start > My Computer > Manage.

2  Double-click Services & Applications

3  Double-click Services. 

4  Right-click the nVidia service. 

5  Choose Properties.

6  Set Startup Type to Disabled.

7  Click Apply, and then click OK.

Installing Pro Tools Hardware
If you do not already have a currently supported 
Pro Tools system installed, you must install your 
Pro Tools hardware. For detailed Pro Tools hard-
ware installation information, see your Getting 
Started Guide. 

Follow the correct PCI or PCIe slot placement of 
your Pro Tools cards according to the informa-
tion in Appendix B, “PCI and PCIe Slot Config-
urations for Avid Video Peripherals.”

For information on supported computers 
and PCI slot configuration, visit the Digide-
sign website (www.digidesign.com).
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Connecting Avid Video 
Peripheral Hardware

To connect Avid video peripheral hardware:

1  Connect the power cable for the Avid video 
peripheral.

2  Connect one end of the FireWire cable to the 
Host port on the Avid video peripheral, and con-
nect the other end to any internal FireWire port 
on your computer.

All FireWire ports on Digidesign-qualified 
computers are connected to the same bus, 
and the Avid video peripheral must be the 
only device attached to this bus. If it is not 
the only device attached to this bus, you 
may see dropped frames, picture distortion, 
or stuttered playback. Therefore, you must 
install a PCI FireWire card if you need to 
connect other FireWire devices. See 
Appendix B, “PCI and PCIe Slot Configura-
tions for Avid Video Peripherals” for more 
information on where to connect a PCI 
FireWire card.

It is critical to follow the card installation 
directions in Appendix B, “PCI and PCIe 
Slot Configurations for Avid Video Periph-
erals” for PCI-based systems.



Connecting a DV Device
(Media Station|PT Only)

To connect a DV device to the Avid video 
peripheral:

Connect one end of the FireWire (1394) cable 
to the DV port on the Avid video peripheral, and 
connect the other end to any available FireWire 
port on the DV Device.

Connecting Serial Digital Video 
Input and Output
(Avid Mojo SDI and AVoption|V10 Only)

To connect a serial digital video (SDI) input to the 
Avid Mojo SDI or AVoption|V10:

Connect one end of a BNC cable to the serial 
digital output on a digital video deck, and con-
nect the other end to the SDI IN port on the 
Avid video peripheral.

To connect the serial digital video output from the 
Avid Mojo SDI or AVoption|V10 to a digital video 
deck:

Connect one end of a BNC cable to the SDI 
OUT port (on Avid Mojo SDI) or either SDI port 
(on AVoption|V10), and connect the other end 
to the serial digital input of the video deck.

All Firewire decks and cameras that are 
connected to Avid video peripheral must be 
powered on after powering on the Avid 
video peripheral.

Avid Mojo SDI and AVoption|V10 do not 
support audio embedded in the SDI stream.
Connecting a SYNC HD or a 
SYNC I/O
(Pro Tools HD Only)

A SYNC HD or SYNC I/O is required for 
Pro Tools systems with an Avid video peripheral. 
For more information on configuring and using 
the SYNC HD or the SYNC I/O, see the SYNC HD 
Guide or the SYNC I/O Guide.

Connecting Video Reference In

When connecting video reference in, the un-
used Video Ref In port must be terminated.

To connect a SYNC HD or SYNC I/O to video 
reference:

Connect one end of a BNC cable to one of the 
Video Ref ports on the SYNC HD or SYNC I/O, 
and connect the other end to a black burst gen-
erator.
Chapter 3: Installing Avid Video Peripherals 17
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To terminate the unused video reference port, do 
one of the following:

Connect the 75-ohm terminator (included 
with the SYNC HD or SYNC I/O) into the un-
used Video Ref port.

– or –

Connect one end of a BNC cable to the un-
used Video Ref port on the SYNC HD or 
SYNC I/O, and connect the other end to the 
Video Ref port on a terminated device (such as 
the Avid Mojo SDI, Avid Mojo, or AVop-
tion|V10).

Connecting Loop Sync In/Out

Loop Sync is the clock signal used to synchro-
nize Pro Tools|HD-series audio interfaces. 

To connect Loop Sync In and Out with a single 
Pro Tools|HD audio interface:

1  Connect one end of a BNC cable to the Loop 
Sync Out port on the SYNC HD or SYNC I/O, 
and connect the other end to the Loop Sync In 
port on the primary Pro Tools|HD audio inter-
face.

2  Connect one end of a BNC cable to the Loop 
Sync Out port on the Pro Tools|HD audio inter-
face, and connect the other end to the Loop 
Sync In port on the SYNC HD or SYNC I/O.

SYNC HD and SYNC I/O video connections

MTC OUTHOST SERIALVIDEO REF VIDEO

IN

OUT

INTERNALLY 
TERMINATED

House Video
Reference
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To connect Loop Sync In and Out with multiple 
Pro Tools|HD audio interfaces:

1  Connect one end of a BNC cable to the Loop 
Sync Out port on the SYNC HD or SYNC I/O, 
and connect the other end to the Loop Sync In 
port on the primary Pro Tools|HD audio inter-
face.

2  Connect one end of a BNC cable to the Loop 
Sync Out port on the Pro Tools|HD audio inter-
face, and connect the other end to the Loop 
Sync In on the next Pro Tools|HD audio inter-
face in the chain. 

3  Repeat Step 2 until you connect the last two 
audio interfaces in the chain.

4  On the last audio interface, connect one end 
of a BNC cable to the Loop Sync Out port, and 
connect the other end to the Loop Sync In port 
on the SYNC HD or SYNC I/O.

Using Centralized Video Switching 
and Routing

Many facilities have centralized video switching 
and routing systems. These systems can be used 
to route Avid video peripheral inputs and out-
puts to flexible input sources and output desti-
nations.

SYNC I/O connection to a Pro Tools|HD audio interface

AC 100-240V, 50-60HZ, .5A 30W

9-PIN  OUT 2

9-PIN OUT 1

x)

IN

OUT

LOOP SYNC

to Loop Sync In
(audio interface)

from Loop Sync Out
(audio interface)



Connecting House Video 
Reference or Black Burst

In most Avid video peripheral setups, the fol-
lowing black burst or house video reference 
(house sync) connections are required: 

• To the Video Ref connector on the 
SYNC I/O

• To a video input on your VTR (a video ref-
erence input if available)

• To the Video Ref connector on the Avid 
video peripheral (this connection can also 
originate from the unused Video Ref port 
on the SYNC I/O)

Read the documentation for your black burst 
generator for more information.

Connecting a VTR

A VTR can be used to provide video input to and 
record video output from the Avid video periph-
eral. In most situations, there are three connec-
tions you need to make:

1  Connect a black burst or house sync output to 
a video input on your VTR (preferably a refer-
ence video input).

2  Connect the Avid video peripheral Composite 
IN, Component IN, S-Video IN, or SDI IN con-
nectors to the corresponding output or outputs 
on your VTR.

3  Connect the Avid video peripheral Composite 
OUT, Component OUT, S-Video OUT, or SDI 
OUT connectors to the corresponding inputs on 
your VTR.

– or –
Connect the Avid video peripheral Composite 
OUT or Component OUT connectors to the cor-
responding input on an NTSC or PAL video 
monitor, then connect the outputs from this 
monitor to the corresponding inputs on your 
VTR.

Connecting an External Video 
Monitor

Connect an external NTSC or PAL video moni-
tor to any of the Composite, Component, or 
S-Video outputs (see “Video Connections for 
AVoption|V10” on page 11).

Starting Up Your System
To ensure that the components of your 
Pro Tools system communicate properly with 
each other, you need to start up your system in 
the correct order.

Start up your Pro Tools system in the following 
order:

1  Turn on the expansion chassis, if any.

2  Turn on any external hard drives.

3  Turn on the SYNC I/O.

4  Turn on the Pro Tools|HD audio interfaces.

5  Turn on the Avid video peripheral.

6  Turn on the DV camcorder or digital video 
deck, if any.

7  Start up your computer.

For detailed information on compensating 
for delays introduced by connecting certain 
types of video displays, see “Compensating 
for Video Monitoring Delays” on page 36.
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Updating Firmware on Pro Tools 
Launch

On launch, Pro Tools checks that the appropri-
ate version of the firmware is installed on the 
Avid video peripheral. If the correct version of 
the firmware is not installed, Pro Tools automat-
ically installs the correct version of the firm-
ware. Once the update is complete, Pro Tools 
will quit and you will be prompted to power-cy-
cle the Avid video peripheral before the upgrade 
will take effect.

Fixing Potential Device Issues When 
Turning on Avid Video Peripheral the 
First Time

(Windows XP with Avid Mojo, Avid Mojo SDI, 
or AVoption|V10 Only)

The first time you power on an Avid Mojo or 
AVoption|V10 peripheral on Windows XP, the 
Found New Hardware Wizard may prompt you 
to locate the driver manually.

To locate the driver:

Click Browse and locate the Flamethrower 
driver at C:\Program Files\Common Files\Avid.

Alternatively, the following warning may dis-
play: “The wizard could not find a better match for 
your hardware than the software you currently have 
installed.”

You might then see this error: 

“A problem occurred during hardware installation. 
Your new hardware might not work properly.:
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To fix this issue:

1  Right-click My Computer, and select Proper-
ties.

2  In the System Properties dialog, click the 
Hardware tab.

3  Click Device Manager.

4  In the Device Manager, click the plus sign (+) 
next to “Sound, Video, and Game Controllers.” 

5  Right-click the Avid Technology AVop-
tion|V10 or Mojo driver and choose Update 
Driver.

System Properties dialog

Device Manager



6  Click Install From a List or Specific Location.

7  Select “Don’t search, I will choose a driver to 
install.” 

One or more drivers should appear in the next 
window. 

8  Choose the driver with the latest version. If 
multiple drivers with the latest version appear in 
the list, choose any driver.

9  Click Next.

10  Click Finish.

Authorizing DigiTranslator 2.0

DigiTranslator 2.0 is authorized using the iLok 
USB Smart Key (iLok) from PACE Anti-Piracy.

The iLok is similar to a dongle, but unlike a don-
gle, it is designed to securely authorize multiple 
software applications from a variety of software 
developers. 

This key can hold over 100 licenses for all of 
your iLok-enabled software. Once an iLok is au-
thorized for a given piece of software, you can 
use the iLok to authorize that software on any 
computer.

DigiTranslator comes with either an Activation 
Code (on the included Activation Card) or an 
iLok License Card: 

• To authorize DigiTranslator using an Activa-
tion Code, see “Authorizing DigiTranslator 
Using an Activation Code” on page 21. 

• To authorize DigiTranslator using an iLok Li-
cense Card, see “Authorizing DigiTranslator 
Using a License Card” on page 22.

The iLok USB Smart Key is not supplied 
with Avid video peripherals. One iLok is in-
cluded with your Pro Tools|HD Core sys-
tem.
Authorizing DigiTranslator Using an 
Activation Code

To authorize DigiTranslator using an Activation 
Code:

1  If you do not have an existing iLok.com ac-
count, visit www.iLok.com and sign up for an 
iLok.com account.

2  Transfer the license for DigiTranslator 2.0 to 
your iLok.com account by doing the following:

• Visit http://secure.digidesign.com/
activation.

• Input your Activation Code (listed on your 
Activation Card) and your iLok.com User 
ID. Your iLok.com User ID is the name you 
create for your iLok.com account.

3  Transfer the licenses from your iLok.com ac-
count to your iLok USB Smart Key by doing the 
following:

• Insert the iLok into an available USB port 
on your computer.

• Go to www.iLok.com and log in.

• Follow the on-screen instructions for trans-
ferring your licences to your iLok.

4  Launch Pro Tools.

5  If you have any installed unauthorized plug-
ins or software options, you will be prompted to 
authorize them. Follow the on-screen instruc-
tions to complete the authorization process.

For information about iLok technology and 
licenses, see the electronic PDF of the iLok 
Usage Guide.
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Authorizing DigiTranslator Using a 
License Card

License Cards are specific to each plug-in or soft-
ware option. You will receive the appropriate Li-
cense Cards for the plug-ins or software options 
that you purchase. License Cards have a small 
punch-out plastic chip called a GSM cutout. 

The authorization steps in this section must be 
repeated for purchased plug-in or software op-
tion. 

To authorize DigiTranslator using a License Card:

1  Insert the iLok into an available USB port on 
your computer.

2  Launch Pro Tools. You will be prompted to au-
thorize any installed unauthorized plug-ins or 
software options.

3  Follow the on-screen instructions until you 
are prompted to insert the License Card into the 
iLok.

4  Separate the GSM cutout from the larger pro-
tective card by pulling it up and out with your 
thumb. Do not force the cutout down with your 
finger.

For additional information about iLok tech-
nology and authorizations, see the elec-
tronic PDF of the iLok Usage Guide.

If you are already using a demo version of 
the plug-in or software option, launch 
Pro Tools before you insert the iLok, then in-
sert the iLok into any available USB port 
when prompted by Pro Tools.
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5  Insert the GSM cutout into the iLok. Visually 
verify that the metal portion of the cutout 
makes contact with the iLok’s metal card reader.

6  Follow the on-screen instructions to complete 
the authorization process for the DigiTranslator 
2.0 option.

7  After the authorization has completed, re-
move the GSM cutout from the iLok. (If you 
have to remove the iLok from the computer to 
remove the cutout, be sure to re-insert the iLok 
in any available USB port on your computer 
when you are finished.)

Using NTSC and PAL

When switching between NTSC and PAL for-
mats, settings must be changed as follows:

• In the Pro Tools Session Setup window, select 
the correct frame rate from the Time Code 
Rate pop-up menu (for example, 25 fps or 
29.97 fps).

• Use the front panel controls of the SYNC I/O 
to set it to the correct format (PAL or NTSC).

• Make sure your black burst matches the de-
sired format.

iLok with License Card



Setting Up Local Storage
For local storage, Pro Tools|HD with Avid video 
peripherals requires a Digidesign-qualified dual-
channel SCSI HBA (host bus adapter) and 
Digidesign-qualified SCSI hard drives. Dedicate 
one SCSI channel to audio drives and one SCSI 
channel to video drives.

For storage requirements and compatibility 
information, see the Digidesign website 
(www.digidesign.com).

Certain computers have been qualified by 
Digidesign using their built-in dual-channel 
SCSI busses. For details, see the Digidesign 
website (www.digidesign.com).
Installing the SCSI Host Bus 
Adapter (HBA)

To install a SCSI HBA:

1  Turn off your computer and any peripherals. 
Leave your computer’s power cable plugged in 
so the computer is grounded.

2  Disconnect all cables attached to the com-
puter (such as hard drives, displays, USB and 
FireWire devices) except for the power cable.

3  Open the computer case.

4  Disconnect the power cable from the com-
puter.

5  Remove the SCSI accelerator card from the 
anti-static bag, being careful to handle it only by 
the edges.

6  Line up the SCSI accelerator card with the in-
stallation slot, and slide the card into place gen-
tly so the PCI connector is aligned with the PCI 
slot.

7  Press down firmly on the card with even pres-
sure. The connector should click into place in 
the PCI slot.

8  Fasten the card in place using the included 
screw to attach the card bracket to the computer 
mounting bracket.

9  Close the computer case, and re-connect all 
cables that were previously attached to the com-
puter.

Before handling any card, discharge static 
electricity from your clothes or body by 
touching a grounded metal surface, such as 
the power supply case inside your computer.
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Drive Configuration Requirements

Audio Pro Tools can store audio data to multiple 
hard drives (which may be necessary, for exam-
ple, to offset the processing requirements for a 
large number of tracks). You should allocate au-
dio tracks to different hard drives manually. 
“Round robin” disk allocation is not recom-
mended in a system that includes video drives. 
For more information, see the Pro Tools Reference 
Guide.

Video Video files may be played from a single 
hard drive, though you must use a “striped set” 
of two or more SCSI drives if you are playing 1:1 
video, or if the size of a single video file exceeds 
the free space on a single drive. It is not possible 
to create a striped set of FireWire drives.

Striped Drive Requirements

(Video Storage Only)

Striped drives are configured so that multiple 
hard drives behave as if they are one hard drive. 
This makes higher data throughput possible. Re-
quirements will vary depending on the drives. 
For example, a 5th-Generation DigiDrive™ (re-
leased November 2001) requires 2-way striped 
drive sets when capturing or playing uncom-
pressed (1:1) video. For earlier generations of 
drives, 4- way striped drives or greater (4 or more 
drives acting as one) are required when captur-
ing or playing uncompressed (1:1) video; and 2-
way striped drives (2 drives acting as one) are re-
quired when capturing or playing 2:1 and 3:1 
compressed video.

For storage requirements and compatibility 
information, see the Digidesign website 
(www.digidesign.com).

Striped drives are supported for video only, 
and not supported for audio record and 
playback
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Formatting and Striping Media Drives 
on Windows XP Systems

To create, format, and stripe drives for video media 
on Windows XP systems:

1  Start your system, and log in to an account 
with administrative privileges. 

2  Right-click the My Computer icon, and select 
Manage. The Computer Management window 
opens.

3  Click the Disk Management folder.

4  Format hard drives intended for audio record 
and playback as NTFS. 

5  To stripe drives for video record and playback, 
make the first drive a Dynamic drive by right-
clicking the disk ID section of the disk in the 
Computer Management window and selecting 
Upgrade to, or Create Dynamic disk, depending 
upon the status of your disk.

When you select a disk in the Computer Man-
agement window, the white section of the disk 
changes to stripes, showing that the section has 
been selected. 

6  Repeat the preceding step for each drive you 
want to stripe. 

7  Right-click one of the Dynamic drives and se-
lect Action > Create Volume.

8  Follow the instructions in the Create Volume 
Wizard to finish striping the drives using NTFS 
format.

Disk drives must be configured as Dynamic 
if you are striping drives. 

For more information on the Computer 
Management window, click the Help icon in 
the toolbar of the Computer Management 
window. 



Formatting and Striping Drives on 
Mac OS X Systems

On Mac OS X, use the Apple Disk Utility to for-
mat your drives Mac OS Extended.

To create a striped set of SCSI drives for 
Mac OS X, you should use ATTO ExpressStripe 
3.0 or later (available separately from ATTO 
Technologies). 

Formatting Video Storage

The following table describes requirements for 
formatting video storage drives for use with 
Pro Tools and Media Station|PT:

Format
Media Station|PT System 
Requirements/Recommendations

HFS+ Required for Mac OS X

NTFS Recommended for Windows XP

FAT 32 Supported only when using Satel-
lite or Standalone mode 
(co-installed with Pro Tools not 
supported)

FAT 32 Supports playback but not record 
in Pro Tools

FAT 16 Not supported for either 
Media Station|PT or Pro Tools
Disabling Windows Drive Indexing
(Windows XP Only)

In order to optimize the usage and speed of your 
media drives, it is recommended that you turn 
off drive indexing.

To turn off drive indexing for external audio and 
video drives:

1  Choose Start > My Computer.

2  Control-click each external audio or video 
drive.

3  Right-click the selected external drive, and 
choose Properties.

4  In the Properties dialog, deselect the option 
called Allow Indexing Service to Index this Disk 
for Fast File Searching.

Checking and Updating ATTO 
Firmware
The cards listed below must be set correctly for 
maximum performance:

• Digidesign SCSI128 card

• ATTO EPCI-UL3D SCSI Host Bus Adapter 
card

• ATTO EPCI-UL5D SCSI Host Bus Adapter 
card

If you are using one of these cards, it is recom-
mended that you verify that you have the 
proper ATTO firmware and drivers (and update 
them if necessary). Refer to the electronic PDF 
version of the ATTO Utilities Read Me (located 
in the ATTO Utilities folder in the Additional 
Files folder on each Pro Tools Installer disc) for 
detailed information.
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Test Sessions
When installation is completed, you can check 
your system by opening and playing one of the 
test sessions installed in the Pro Tools Utilities 
Folder (Pro Tools\Pro Tools Utilities\
AVoptionDNA Tests\):

• AVoptionDNA Test NTSC.pts

• AVoptionDNA Test PAL.pts

If your system is working correctly, you will see 
a brief video and hear 2 tracks of audio on play-
back.
Avid Video Peripherals Guide



chapter 4

Working with Avid Video on the Video Track
This chapter describes Avid-specific video fea-
tures in Pro Tools.

Capabilities of Pro Tools with 
Avid Video Peripherals
Pro Tools with an Avid video peripheral lets you 
do the following:

• Digitize video (Pro Tools HD only)

• Import, play back, and edit multiple types 
of video files in the Timeline, including 
video files created in a compatible Avid 
video application 

• Scrub video in the Video window

Video Track Options with Avid 
Video Peripherals
When an Avid video peripheral is connected to 
any Pro Tools system and powered on, you can 
add Avid video to an empty video track. In addi-
tion, all video tracks also display I/O View op-
tions and an Avid video icon.

See the Pro Tools Reference Guide for de-
tailed information on working with video 
features that apply to both QuickTime mov-
ies and Avid video.
With Pro Tools HD, video tracks with Avid 
video display the following:

• Record Enable button

• Expanded I/O View options

Record Enable Button

The Record Enable button lets you arm the main 
video track for digitizing video to the Timeline. 
It displays only on the main video track, and 
does not appear on video tracks containing 
QuickTime movies.

Video track with Record Enable button shown

Control-clicking (Windows) or Option-
clicking (Mac) an audio track’s Record En-
able button does not arm the video track for 
recording.

Record Enable button
C
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I/O View

The video track’s I/O view displays differently 
depending on whether you are using 
Pro Tools LE, Pro Tools HD, or QuickTime mov-
ies, as follows:

• With Pro Tools LE or when using QuickTime 
video in the video track, the I/O View displays 
the Video Output selector and the current 
video output format (NTSC or PAL).

• With Pro Tools HD using Avid video or no 
video in the video track, the I/O View has In-
put, Output, and Video Record Volume selec-
tors, as well as a display for the current video 
output format (NTSC or PAL) and available 
record time.

To show the I/O View in the Edit window:

• Choose View > Edit Window > I/O.

Video Track Input/Output View (Pro Tools HD with Avid 
video shown)

For details on using the Input/Output view 
with the video track, see “Digitizing Video 
to the Pro Tools Timeline” on page 31.

Video Input selector

Video Output selector

Current Video Format

Video Record Volume

Approximate Minutes
Available indicator
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Video Input Selector

(Pro Tools HD with Avid Video Only)

The Video Input Selector lets you choose from 
the following video inputs on an Avid video pe-
ripheral:

• Component

• Composite

• S-Video

• SDI (Avid Mojo SDI and AVoption|V10 
only)

Video Output Selector

The Video Output Selector lets you choose from 
the following video outputs for an Avid Mojo or 
Avid Mojo SDI: 

• Component

• S-Video + Composite

For AVoption|V10, all outputs are active at all 
times.

Current Video Format

The I/O View displays the current session’s 
video format (NTSC or PAL) as designated in the 
Session Setup window.

Video Record Volume Selector

(Pro Tools HD with Avid Video Only)

The Video Record Volume Selector lets you se-
lect one volume at a time for video recording. 
Volumes that are not designated as record vol-
umes in the V column of the DigiBase browser 
will not be available in this list. 



Selecting any volume in this selector will create 
a session and Video Files folder on that volume, 
even if you do not record any video there. (If 
you close a new session without recording any 
video, however, the empty Video Files folder is 
automatically deleted.)

Approximate Minutes Available

(Avid Video Only)

When the Record Enable button is enabled in 
the video track, this indicator shows the approx-
imate recording time (in minutes) available on 
the volume shown in the Video Record Volume 
Selector. This display does not update while 
video is being digitized.

Exporting Sequences from 
Avid Applications
Projects created on an Avid video editing system 
(such as Avid Media Composer or Avid 
Media Station|PT) can be exported as AAF or 
OMF 2.0 sequences and imported into Pro Tools 
with an Avid video peripheral. This exchange of 
data between applications is significantly faster 
and easier than other methods, such as laying 
off to tape and re-digitizing.

When an AAF or OMF sequence exported from 
Avid software is imported into Pro Tools, video 
tracks display each of the video files as regions 
in the Edit window. Generally, these regions re-
flect the clips on the Avid timeline, unless an ef-
fect spans more than one video clip.

When exporting sequences from an Avid 
application, AAF is the recommended for-
mat because it carries more data and is 
more recognized than OMF as a standard.
All video effects, including fades, titles and 
multi-stream effects, must be rendered before 
they can be exported in an AAF or OMF 2.0 se-
quence for import into Pro Tools. Rendering 
means that a media file called a “precompute” is 
created. This precompute is what is referenced 
by the exported sequence and what appears in 
the Pro Tools Edit window. For example, if there 
are three video clips in the Avid timeline and a 
title effect is laid across all three, the title would 
have to be rendered before export, creating a 
single precompute file. Then, instead of seeing 
the three original video files in the Pro Tools 
Edit window, only the one pre compute clip will 
be displayed.

Pro Tools can import and play sequences con-
taining one or more single-stream clips, video 
editing metadata video tracks, or video mix-
down tracks.

Exporting AAF Sequences with 
Special Options

Most Avid applications released after May, 2006 
let you export AAF sequences that reference an 
OMF, MXF, or QuickTime audio or video mix-
down and its corresponding metadata for indi-
vidual edits. Avid applications can also export 
directly to DigiDelivery or Avid Interplay.

To export both a video mixdown and its corre-
sponding editing metadata, the Avid video edi-
tor should choose Video Mixdown from the Ex-
port Method pop-up menu, then select 
Mixdown with Video Edits in the Export Set-
tings dialog.

To export both an audio mixdown and its corre-
sponding editing metadata, the Avid video edi-
tor should select Add Audio Mixdown Tracks in 
the Export Settings dialog.
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To export directly to DigiDelivery, the Avid 
video editor should choose DigiDelivery from 
the Export Method pop-up menu.

Avid Multi-Cam Resolution Files

(Avid Mojo SDI, Avid Mojo, and AVoption|V10 
Only)

Pro Tools with any Avid video peripheral sup-
ports all standard-definition Avid Multi-Cam 
Resolution files for import and playback. 
Pro Tools will play the clip of an Avid Multi-
Cam Resolution file that was being used as the 
active camera angle when the file was exported 
to AAF or OMF.

See the DigiDelivery Guide for detailed in-
formation on using DigiDelivery.
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Importing Sequences from 
Avid Applications
Pro Tools with DigiTranslator 2.0 and an Avid 
video peripheral lets you import AAF and OMF 
sequences exported from Avid editing applica-
tions by doing one of the following:

• Selecting File > Import > Session Data

• Selecting File > Open when no session is 
open, and selecting an AAF or OMF se-
quence

• Dragging them from the desktop or a Digi-
Base browser to Pro Tools

• Selecting File > Import > Sequence from 
Avid Interplay (Avid Interplay system only)

If the sequence contains a video mixdown, the 
video mixdown and its corresponding metadata 
are displayed in two separate video tracks on the 
Timeline.

If the sequence contains an audio mixdown, the 
audio mixdown and its corresponding metadata 
are displayed in two separate audio tracks on the 
Timeline.

For more details on the Import Session Data 
dialog, see the Pro Tools Reference Guide.

Video tracks with editing metadata and video mixdown



Digitizing Video to the 
Pro Tools Timeline
(Pro Tools HD Only)

Pro Tools with an Avid video peripheral lets you 
digitize video directly to the video track for use 
in the Pro Tools editing environment. 

Video is digitized in the Avid DV25 file format, 
and may be used in the video track along with 
Avid OMF and MXF video files of other resolu-
tions that are from other sources. Though the 
video files which are captured in Pro Tools are 
technically MXF files, they are intended only for 
use in Pro Tools. They have not been tested for 
import into other applications, and may not be 
of standard broadcast quality.

Hardware Requirements and 
Options

SYNC HD and SYNC I/O Requirement

For digitizing video, Pro Tools requires a 
SYNC HD or SYNC I/O locked to video refer-
ence.

For information about setting up SYNC HD or 
SYNC I/O hardware and locking the synchroni-
zation peripheral to video reference, see the 
SYNC HD User Guide or the SYNC I/O User’s 
Guide.

Up to six hours of video can be digitized in 
a single record pass.

Each record pass can only record to a single 
volume (or a set of striped drives). One video 
file cannot be recorded across multiple vol-
umes.
To configure SYNC HD or SYNC I/O for digitizing 
video in Pro Tools:

1  Ensure that the SYNC HD or SYNC I/O is 
locked to the appropriate video reference for 
your system setup. For more information, see 
the SYNC HD Guide, SYNC I/O Guide, or the Ma-
chineControl Guide.

2  In the Session Setup window (Setup > Session), 
select SYNC from the Clock Source pop-up 
menu.

3  Choose a Time Code Rate for the type of video 
you want to record.

4  Under the SYNC Setup & Time Code Offsets 
section, select Video Reference (SD) or Video 
Reference (HD) from the Clock Reference pop-
up menu.

Session Setup window Clock Source selection

Ensure that the Time Code Rate is compati-
ble with the type of video format you plan to 
use. For example, NTSC is not compatible 
with a Time Code Rate of 25 frames per sec-
ond.

Session Setup window Clock Reference selection
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5  Choose the appropriate format from the 
Video Format pop-up menu, as follows:

• If you selected Video Reference (SD) in the 
Clock Reference pop-up menu, you can 
choose from NTSC or PAL.

• If you selected Video Reference (HD) from 
the Clock Reference pop-up menu, you can 
choose from multiple HD video formats.

Session Setup window Video Formats for Video 
Reference (SD)

Session Setup window Video Formats for Video 
Reference (HD)
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6  The Video format you choose is reflected in 
the video track’s I/O View.

7  Under the Time Code Settings section, dese-
lect the Using SYNC option.

Timebase Correction

Avid video peripherals require that all sources be 
timebase corrected. Most professional video 
decks have built-in timebase correction. To find 
out whether or not your video deck has built-in 
timebase correction, refer to the manufacturer’s 
documentation.

Video Track Input/Output View (NTSC displayed)

Session Setup window Time Code Settings section

The SYNC HD or SYNC I/O must be locked 
to video reference in order to digitize video 
and play back in sync.

Current Video Format



MachineControl

You can use Digidesign MachineControl soft-
ware (purchased separately) to remotely control 
your external video deck during Pro Tools cap-
ture. When recording to the video track with 
MachineControl, it is recommended that the 
Track View be set to Blocks.

For more information, see the MachineControl 
Guide.

Digitizing Video in Pro Tools

To set video recording options:

1  Choose Track > New.

2  In the New Tracks dialog, do the following:

• Select Video Track from the Track Type 
pop-up menu.

– and –

• Enter the number of new video tracks.

3  Click Create.

4  Select View > Edit Window > I/O.

Digidesign MachineControl does not con-
trol FireWire-connected devices. 
5  In the Edit window, with I/O View enabled, 
use the video track's Input Selector to choose 
one of the following video inputs:

• Component

• Composite

• S-Video

• SDI (Avid Mojo SDI and AVoption|V10 
only)

6  For Avid Mojo, use the video track's Output 
Selector to choose one of the following video 
outputs:

• Component

– or –

• S-Video + Composite

7  Select the video record volume from the Video 
Record Volume selector. 

Selecting Video Input from the Video Input Selector

For Avid Mojo SDI and AVoption|V10, all 
outputs are active at all times.

Selecting a drive for video capture

Clicking the Record Enable button in the 
video track will display the approximate re-
cording time available (in minutes) under 
the Video Record Volume Selector. 
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Pro Tools will create a Video Files folder in the 
session folder on the video record volume. If 
this volume is different than the volume on 
which your session was originally saved, Pro 
Tools will also create a new session folder on the 
target volume matching the name of the current 
session.

To digitize video to the video track:

1  In the Edit window, do one of the following:

• Place the Playback cursor where you want 
to start recording.

– or –

• Make a selection on a Timebase Ruler or on 
a track to select a range of time for the re-
cording. (To make a selection on a track, 
Link Edit and Timeline Selection must be 
enabled in the Operations menu.)

2  Confirm the video track is online (blue). 

3  Record enable the video track by clicking the 
Record Enable button. The approximate record-
ing time available on the selected video record 
volume will be displayed (in minutes) below the 
Video Record Volume selector. This display does 
not update while video is being digitized.

If you want to digitize video without speci-
fying a selection in the Timeline, the video 
record volume must have at least 200 MB of 
available space. You can also limit the 
amount of recording time by changing the 
Open Ended Record Allocation settings (lo-
cated in Setups > Preferences > Operations).

Because it is not possible to record a partial 
frame of video, selections in the video track 
are rounded to the frame boundaries. This 
means that the start of the selection is 
moved earlier to the nearest frame boundary 
and the end of the selection is moved later to 
the next frame boundary.
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4  Do one of the following:

• To record with the video’s time code syn-
chronized to the session time code when 
the MachineControl option is installed, 
click the Online button in the Transport 
window to enable it, then click Record in 
the Transport window. The VTR will locate 
to the correct time code and begin record-
ing.

• To record with the video’s time code syn-
chronized to the session time code when 
the MachineControl option is not installed, 
first slave Pro Tools to incoming LTC or 
VITC time code, then click the Online and 
Record buttons in the Transport window. 
Manually start playback on the VTR to be-
gin recording.

• To record video without synchronizing to 
time code, ensure the Online button in the 
Transport window is not enabled. Manu-
ally start playback on the VTR, then click 
Record and Play in the Transport window 
to begin recording.

See the Pro Tools Reference Guide for infor-
mation about slaving to LTC or VITC time 
code.

Transport window

Online
button



5  When you have finished recording, click Stop 
in the Transport window.

To abort a record pass:

• Press Control+period (Windows) or Com-
mand+period (Mac) to abort a record pass in 
progress and restore the video track to its orig-
inal state. The video that you digitized before 
aborting will be deleted from disk.

To undo a record pass:

• Choose Edit > Undo to undo a record pass af-
ter it has completed. The digitized video will 
be removed from the video track, and any 
video regions that were overwritten will be re-
stored.

When you undo a record pass, the digitized 
video will be removed from the video track, but 
will not be removed from disk until you quit 
Pro Tools.

Dropouts During Video Digitize

When recording video, a dropout may occur in 
the video signal. Dropouts can be caused by bad 
cable connections, dropouts in the source tape, 
or other problems. When Pro Tools detects a 
dropout in video signal while recording, a warn-
ing dialog appears. The recording will continue 
as specified and may still be usable. 

If you record over existing video regions in 
the video track, the actual video files remain 
intact. All video recording in Pro Tools is 
non-destructive.
Because the Location Indicators freeze when the 
warning dialog appears, it is recommended that 
you make a note of the location shown in the in-
dicators before dismissing the dialog, then do 
the following:

• Check the recorded video near that loca-
tion to see if the error caused an unaccept-
able dropout. 

• Check the video recorded after the initial 
dropout, as the warning is only posted for 
the first occurrence and there may be other 
errors later in the recording.

Matching Audio and Video Names for 
Digitized Video

When Pro Tools with an Avid video peripheral 
completes a single video capture, it appends the 
captured audio and video files with matching 
suffixes (such as _01). For example, captured au-
dio and video files might be called Audio 1_01, 
Audio 2_01, and Video 1_01 where _01 is the 
shared suffix.

On each successive capture, Pro Tools incre-
ments the numbered suffix to the filenames by 
one to distinguish the new set of captured media 
files from the last. For example, the new cap-
tured media files would be appended with _02 if 
the last were appended with _01.

Editing Avid Video in the 
Timeline
Once you have digitized or imported Avid video 
to the Timeline, you can select, move, group, 
and edit video regions with or without audio re-
gions.

See the Pro Tools Reference Guide for de-
tailed information on working with video 
regions in the Timeline.
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Scrubbing Avid Video in the 
Video Window
Due to the latency introduced by all FireWire-
based video peripherals, the video on an exter-
nal monitor will not be in sync with the Scrub-
ber tool. To scrub video without latency, you 
can scrub in the Video window on the desktop.

To scrub in the Video window:

1  Select Options > Scrub in Video Window.

2  Select the Scrubber tool and drag within the 
main video track.

Compensating for Video 
Monitoring Delays 
You can compensate for delays in video output 
introduced by certain types of displays, such as 
plasma monitors.

To compensate for delays caused by video 
monitoring devices:

1  Choose Setup > Video Sync Offset.

2  In the Video Sync Offset dialog, enter a value 
appropriate to compensate for the delay caused 
by your video monitor chain. (Third-party de-
vices are available to help you measure this de-
lay.)

See the Pro Tools Reference Guide for de-
tailed information on moving, resizing, and 
changing other options for the Video win-
dow.
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Avid Video Offset When playing Avid video 
through an Avid video peripheral, Pro Tools au-
tomatically compensates for the delay intro-
duced by the peripheral. This means you can 
leave the setting at 0 frames and the output of 
the Avid video peripheral will be in sync with 
the audio. If a plasma monitor or other device 
introduces additional delay, you can compen-
sate for it by entering the amount of the delay 
here.

QuickTime Video Offset Pro Tools does not auto-
matically compensate for the delay when play-
ing QuickTime video through any FireWire pe-
ripheral, including Avid video peripherals. The 
amount of delay introduced varies based on 
your system and the type of video peripheral 
you are using. When using an Avid peripheral 
with QuickTime, 18 quarter-frames is a good 
starting point, but you will need to verify the 
precise setting for your system. (Third-party de-
vices are available to help you measure this de-
lay.)

Once this value has been set, it should not need 
to be updated unless you change components in 
your video monitoring chain (such as projectors 
or plasma screens).

Video Sync Offset dialog



Adjusting Video Black Output 
Level
When outputting NTSC Avid video from 
Pro Tools, you can adjust the level of NTSC 
video black output to 7.5 IRE or 0 IRE. 

The black level of NTSC signals for the United 
States and many other countries are generally 
calibrated to 7.5 IRE, also known as Setup. Some 
other countries (such as Japan) require NTSC 
signals to be output at a black level of 0 IRE.

To adjust the level of black output in Pro Tools:

1  Choose Setup > Preferences, and click the Op-
eration tab.

2  Do one of the following:

• To output black level at 0 IRE, select the 
NTSC Has Setup option.

• To output black level at 7.5 IRE, deselect 
the NTSC Has Setup option.

3  Click OK.

4  Restart Pro Tools.

Changing this option requires you to restart 
Pro Tools.
Looping Audio with Avid Video 
Present
When working with a session containing Avid 
video, you can now select and loop a portion of 
audio without having the loop selection snap to 
video frame boundaries. For example, you can 
create a loop lasting exactly four bars regardless 
of where the video frame boundaries lie.

To make an audio selection that does not snap to 
frame boundaries:

1  With the Selector tool, select the track range 
you want to loop in an audio track, making sure 
not to include any video tracks in the selection.

2  Select Options > Loop Playback. When en-
abled, a loop symbol appears in the Play button 
in the Transport window.

– or –

You can also enable Loop Playback by doing one 
of the following:

• Right-clicking (Windows) or Control-click-
ing (Mac) the Play button in the Transport 
window. 

• With the Numeric Keypad mode set to 
Transport, press 4 on the numeric keypad.

3  Click Play in the Transport window.

Including any video in the selection will 
cause the selection to snap to the video 
frame boundary during playback.

Loop Playback enabled
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appendix a

24fps Workflows
Audio Layback to Video

Although you cannot output 24P video to a 
video recorder with Pro Tools, you can “Punch 
Down” by adding audio that has been posted to 
a 24P video clip in Pro Tools to videotape that 
was created on another video system.

Pro Tools with an Avid video peripheral 
does not support 24 or 23.976 fps video out-
put. Though 24 and 23.976 fps video files 
are supported, the actual output of 
Pro Tools is limited to NTSC (29.97 fps) 
and PAL (25 fps) standards. On playback, 
the 24 fps files are converted in software to 
these standards. The conversion can pro-
duce visible artifacts. Therefore, Pro Tools 
video playback is intended for monitoring 
purposes only, and is not suitable for profes-
sional layback or broadcast, regardless of 
the resolution or frame rate of the video clip.
Playing in Sync with 24 fps Video Tapes

To play back synchronized to a video transport 
playing at 24 fps:

1  In Pro Tools, open the Session Setup window 
(Setup > Session).

2  Set the Frame Rate to 24 fps.

3  Slave Pro Tools to the video transport. 

– or –

If the MachineControl option is installed, select 
the appropriate profile to control the video 
transport.
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Playing in Sync with 29.97 fps (NTSC) 
Video Tapes

To play in sync with a 29.97 fps video created from 
a 24 fps source:

1  Slave Pro Tools to the VTR.

2  Choose Setup > Session.

3  From the Frame Rate pop-up menu, select 
29.97 FPS.

4  If the audio in Pro Tools is running at film 
speed (24 fps), choose 0.1% Down from the Au-
dio Rate Pull Up/Down pop-up menu.

For more information on slaving Pro Tools 
to the VTR, see the Synchronization chap-
ters of the Pro Tools Reference Guide.

Audio pull-down is required when you are 
posting to a 29.97 fps video clip made from 
a 24 fps source. This is because the 24 fps 
source is also “pulled down” by the telecine 
process which produces the 29.97 fps tape.
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Playing in Sync with 25 fps (PAL) Video 
Tapes

To lay back a 24P session directly to a 25 fps 
(PAL) tape:

1  Choose Setup > Session.

2  From the Frame Rate pop-up menu, select 
25 FPS.

3  From the Audio Rate Pull Up/Down pop-up 
menu, select 4.0% Up.



appendix b

PCI and PCIe Slot Configurations for Avid 
Video Peripherals

This appendix covers PCI and PCIe slot configurations for Pro Tools|HD systems with Avid video pe-
ripherals on Windows and Mac. These slot configurations have been qualified and recommended by 
Digidesign.

Summary of Recommended Windows PCI and PCIe Slot 
Configurations
This section summarizes qualified and recommended PCI and PCIe slot configurations for the follow-
ing Windows machines with or without expansion chassis, for both local and shared storage:

• HP xw8400

• HP xw9300

• Dell Precision 690 750w

HP xw8400

HP xw8400 with host cards (shared storage)

• ATTO Celerity FC-41ES PCIe host card to 4 GB Unity MediaNetwork

• ATTO Celerity FC-41XS PCI host card to 4 GB Unity MediaNetwork 

• ATTO 3300FC PCI host card to 2/4 GB Unity MediaNetwork

See “Shared Storage Slot Configurations for HP xw8400 with Host Cards” on page 45.
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HP xw8400 with expansion chassis (shared storage)

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card, using ATTO Celerity FC-41XS PCI 
host card to 4 GB Unity MediaNetwork

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe 
host card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork 

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41XS PCI host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41XS PCI host 
card to 4 GB Unity MediaNetwork

See “Shared Storage Configurations for HP xw8400 with Expansion Chassis” on page 47.

HP xw8400 with expansion chassis (local storage)

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

See “Local Storage Configurations for HP xw8400 with Expansion Chassis” on page 50.

HP xw9300

HP xw9300 with host cards (shared storage)

• ATTO Celerity FC-41ES PCIe host card to 4-GB Unity MediaNetwork 

• ATTO Celerity FC-41XS PCI host card to 4 GB Unity MediaNetwork 

• ATTO 3300FC PCI host card to 2/4 GB Unity MediaNetwork

See “Shared Storage Slot Configurations for HP xw9300 with Host Cards” on page 52.

HP xw9300 with expansion chassis (shared storage)

• Digidesign Expansion|HD PCI Chassis, using ATTO Celerity FC-41XS PCI card to 4 GB Unity Medi-
aNetwork 

• Digidesign Expansion|HD PCI Chassis, using ATTO Celerity FC-41ES PCIe card to 4 GB Unity Me-
diaNetwork

See “Shared Storage Slot Configurations for HP xw9300 and Digidesign Expansion|HD Chassis” on 
page 54.
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HP xw9300 with expansion chassis (local storage) 

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

See “Local Storage Slot Configurations for HP xw9300 with Expansion Chassis” on page 56.

Dell Precision 690 750W

Dell Precision 690 750W with host cards (local storage)

• ATTO Celerity FC-41ES PCIe host card to 4 GB Unity MediaNetwork 

See “Local Storage Configurations for Dell Precision 690 750w Host Cards” on page 58.

Dell Precision 690 750W with expansion chassis (shared storage)

• Magma 64-bit 7-Slot Expansion PCI Chassis, with ATTO Celerity FC-41ES PCIe host card to 4 GB 
Unity MediaNetwork 

• Magma 64-bit 7-Slot Expansion PCI Chassis, using ATTO Celerity FC-41XS PCI host card to 4 GB 
Unity MediaNetwork 

• Magma 64-bit 7-Slot Expansion PCI Chassis, using ATTO 3300FC PCI host card to 2/4 GB Unity Me-
diaNetwork

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

See “Shared Storage Configurations for Dell Precision 690 750w with Expansion Chassis” on page 59.

Dell Precision 690 750W with expansion chassis (local storage)

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

See “Local Storage Configurations for Dell Precision 690 750w with Expansion Chassis” on page 61.
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Summary of Mac PCI and PCIe Slot Configurations
This section summarizes qualified and recommended PCI and PCIe slot configurations for the follow-
ing Mac machines for local storage with or without expansion chassis:

• Apple Mac Pro

• Apple G5 PCI

• Apple G5 PCIe

Apple Mac Pro

• Apple Mac Pro with host cards

• Apple Mac Pro with Magma PE6R4

• Apple Mac Pro with Digidesign Expansion|HD Chassis

See “Apple Mac Pro” on page 63.

Apple G5 PCI

• Apple G5 PCI with host cards

• Apple G5 PCI with Magma 64-bit 7-Slot Expansion Chassis and PCI Host Card

• Apple G5 PCI with Digidesign Expansion|HD Chassis and PCI Host Card

See “Apple G5 PCI” on page 64.

Apple G5 PCIe

• Apple G5 PCIe with host cards

• Apple G5 PCIe with Magma 64-bit 7-Slot Expansion Chassis and PCI Host Card

• Apple G5 PCIe with Digidesign Expansion|HD Chassis and PCI Host Card

See “Apple G5 PCIe” on page 66.
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HP xw8400 PCI and PCIe Slot Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400.

Shared Storage Slot Configurations for HP xw8400 with Host Cards

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400 
systems, connected to shared storage via the following host cards:

• ATTO Celerity FC-41ES PCIe host card to 4 GB Unity MediaNetwork

• ATTO Celerity FC-41XS PCI host card to 4 GB Unity MediaNetwork 

• ATTO 3300FC PCI host card to 2/4 GB Unity MediaNetwork

HP xw8400: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) HD Core card

CPU Slot 6 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 7 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card
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HP xw8400: ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

HP xw8400: ATTO 3300FC PCI Host Card to 2 GB/4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

CPU Slot 6 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 7 (100MHz PCI 64-bit) HD Core card

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) HD Core card
Warning: Do not insert an ATTO 3300FC card into any 133MHZ PCI slot. 
This will cause damage to your HBA card and may also cause data loss 
on the server.

CPU Slot 6 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 7 (100MHz PCI 64-bit) ATTO 3300FC PCI card
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Shared Storage Configurations for HP xw8400 with Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400 
systems, with the following expansion chassis and host cards connected to shared storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card, using ATTO Celerity FC-41XS PCI 
host card to 4 GB Unity MediaNetwork

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe 
host card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork 

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41XS PCI host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41XS PCI host 
card to 4 GB Unity MediaNetwork

HP xw8400 and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI Host Card: 
ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 with Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI Host Card: 
ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card:
ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Digidesign Expansion|HD Host PCIe card

CPU Slot 4 (PCIe) ATTO Celerity FC-41ES PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Untested

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card:
ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

Local Storage Configurations for HP xw8400 with Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw8400 
systems, with the following expansion chassis and host cards connected to local storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Digidesign Expansion|HD Host PCIe card

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Untested

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI Host Card

HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Digidesign Expansion|HD Host PCIe card

CPU Slot 5 (133MHz PCI 64-bit) Untested

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw8400 and Digidesign Expansion|HD PCI Chassis with PCI Host Card

HP xw9300 PCI and PCIe Slot Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
computers for use with Avid video peripherals.

Shared Storage Slot Configurations for HP xw9300 with Host Cards

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
systems connected to shared storage via the following host cards:

• ATTO Celerity FC-41ES PCIe host card to 4-GB Unity MediaNetwork 

• ATTO Celerity FC-41XS PCI host card to 4 GB Unity MediaNetwork 

• ATTO 3300FC PCI host card to 2/4 GB Unity MediaNetwork 

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (32-bit) Do not use

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe) Untested

CPU Slot 4 (PCIe) Untested

CPU Slot 5 (133MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 6 (100MHz PCI 64-bit) Untested

CPU Slot 7 (100MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw9300: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

HP xw9300: ATTO Celerity FC-41XS PCI Host Card to 4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) ATTO Celerity FC-41ES PCIe card

CPU Slot 4 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 5 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 6 (133MHz PCI 64-bit) HD Core card

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

CPU Slot 5 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 6 (133MHz PCI 64-bit) HD Core card
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HP xw9300: ATTO 3300FC PCI Host Card to 2 GB/4 GB Unity MediaNetwork

Shared Storage Slot Configurations for HP xw9300 and Digidesign 
Expansion|HD Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
systems and the Digidesign Expansion|HD PCI Chassis, with the following host cards connected to 
shared storage:

• ATTO Celerity FC-41XS PCI card to 4 GB Unity MediaNetwork 

• ATTO Celerity FC-41ES PCIe card to 4 GB Unity MediaNetwork 

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) ATTO 3300FC PCI card

CPU Slot 5 (100MHz PCI 64-bit) Optional: HD Accel or HD Process card

CPU Slot 6 (133MHz PCI 64-bit) HD Core card
Warning: Do not insert an ATTO 3300FC card into any 133MHZ PCI slot. 
This will cause damage to your HBA card and may also cause data loss 
on the server.
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HP xw9300 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
ATTO Celerity FC-41XS PCI Card to 4 GB Unity MediaNetwork

HP xw9300 and Digidesign Expansion|HD PCI Chassis with PCI Host Card:
ATTO Celerity FC-41ES PCIe Card to 4 GB Unity MediaNetwork

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) ATTO Celerity FC-41XS PCI card

CPU Slot 6 (133MHz PCI 64-bit) Expansion|HD Host PCI Card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) ATTO Celerity FC-41ES PCIe card

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Expansion|HD Host PCI Card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Local Storage Slot Configurations for HP xw9300 with Expansion 
Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for HP xw9300 
systems, with the following expansion chassis and host cards connected to local storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

HP xw9300 and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Magma 64-bit Expansion HBA card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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HP xw9300 and Digidesign Expansion|HD PCI Chassis with PCIe Host Card

HP xw9300 and Digidesign Expansion|HD PCI Chassis with PCI Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Expansion|HD Host PCIe Card

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Untested

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (PCIe x16) Untested

CPU Slot 2 (PCIe) Monitor card

CPU Slot 3 (PCIe x16) Untested

CPU Slot 4 (100MHz PCI 64-bit) Untested

CPU Slot 5 (100MHz PCI 64-bit) Untested

CPU Slot 6 (133MHz PCI 64-bit) Expansion|HD Host PCI Card

Chassis Slot 1 (closest to 
power supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Dell Precision 690 750w Recommended PCI and PCIe Slot 
Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for Dell 
690 750w computers for use with Avid video peripherals.

Local Storage Configurations for Dell Precision 690 750w Host Cards

This section describes qualified and recommended PCI and PCIe slot configurations for Dell Precision 
690 750W systems with the following cards in the host:

• ATTO Celerity FC-41ES PCIe host card to 4 GB Unity MediaNetwork 

ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork
 

Slot Card

CPU Slot 1 (PCIe x8) ATTO Celerity FC-41ES PCIe card

CPU Slot 2 (100MHz PCI 64-bit) HD Core card

CPU Slot 3 (100MHz PCI 64-bit) Optional: HD Accel, HD Process

CPU Slot 4 (33MHz PCI 32-bit) Optional: HD Accel, HD Process

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested
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Shared Storage Configurations for Dell Precision 690 750w with 
Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for Dell Precision 
690 750W with the following expansion chassis and host cards connected to shared storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis, with ATTO Celerity FC-41ES PCIe host card to 4 GB 
Unity MediaNetwork 

• Magma 64-bit 7-Slot Expansion PCI Chassis, using ATTO Celerity FC-41XS PCI host card to 4 GB 
Unity MediaNetwork 

• Magma 64-bit 7-Slot Expansion PCI Chassis, using ATTO 3300FC PCI host card to 2/4 GB Unity Me-
diaNetwork

• Digidesign Expansion|HD PCI Chassis with PCI host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

• Digidesign Expansion|HD PCI Chassis with PCIe host card, using ATTO Celerity FC-41ES PCIe host 
card to 4 GB Unity MediaNetwork

Dell Precision 690 750w and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI 
Host Card: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (PCIe x8) ATTO Celerity FC-41ES PCIe card

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Dell Precision 690 750w and Digidesign Expansion|HD PCI Chassis with PCI Host 
Card: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Dell Precision 690 750w and Digidesign Expansion|HD PCI Chassis with PCIe Host 
Card: ATTO Celerity FC-41ES PCIe Host Card to 4 GB Unity MediaNetwork

Slot Card

CPU Slot 1 (PCIe x8) Untested

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) ATTO Celerity FC41-ES PCIe card

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot Card

CPU Slot 1 (PCIe x8) Digidesign Expansion|HD Host PCIe card

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Untested

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) ATTO Celerity FC41-ES PCIe card

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Local Storage Configurations for Dell Precision 690 750w with 
Expansion Chassis

This section describes qualified and recommended PCI and PCIe slot configurations for Dell Precision 
690 750W systems, with the following expansion chassis and host cards connected to local storage:

• Magma 64-bit 7-Slot Expansion PCI Chassis with PCI host card

• Digidesign Expansion|HD PCI Chassis with PCIe host card

• Digidesign Expansion|HD PCI Chassis with PCI host card

Dell Precision 690 750w and Magma 64-Bit 7-Slot Expansion PCI Chassis with PCI 
Host Card

Slot Card

CPU Slot 1 (PCIe x8) Untested

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Dell Precision 690 750w and Digidesign Expansion|HD PCI Chassis with PCIe Host 
Card

Dell Precision 690 750w and Digidesign Expansion|HD PCI Chassis with PCI Host 
Card

Slot Card

CPU Slot 1 (PCIe x8) Digidesign Expansion|HD Host PCIe card

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Untested

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot Card

CPU Slot 1 (PCIe x8) Untested

CPU Slot 2 (100MHz PCI 64-bit) Untested

CPU Slot 3 (100MHz PCI 64-bit) Digidesign Expansion|HD Host PCI card

CPU Slot 4 (33MHz PCI 32-bit) Do not use

CPU Slot 5 (PCIe x8) Untested

CPU Slot 6 (PCIe x16) Monitor card

CPU Slot 7 (PCIe x8) Untested

Chassis Slot 1 (closest to power 
supply)

HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
Avid Video Peripherals Guide



Mac PCI and PCIe Slot Configurations
This section describes qualified and recommended PCI and PCIe slot configurations for Apple Mac 
machines.

Local Storage Configurations for Apple Mac Pro

This section describes qualified and recommended PCI and PCIe slot configurations for the following 
Apple Mac Pro systems:

• Apple Mac Pro

• Apple Mac Pro and Magma PE6R4 chassis with PCIe host card

• Apple Mac Pro and Digidesign Expansion|HD chassis with PCIe host card

Apple Mac Pro

Apple Mac Pro and Magma PE6R4 Chassis with PCIe Host Card

Digidesign does not support shared storage via Avid Unity MediaNetwork or Avid Unity ISIS on 
Mac OS X.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 HD Core card

CPU Slot 3 Optional: HD Accel or HD Process card

CPU Slot 4 (133MHz 64-bit) Optional: HD Accel card, HD Process card, SCSI PCIe card, FireWire PCIe 
card

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Magma 6 Slot PE6R4 PCIe card

CPU Slot 3 Optional: SCSI PCIe card or FireWire PCIe card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe card or FireWire PCIe card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Apple Mac Pro and Digidesign Expansion|HD Chassis with PCIe Host Card

Local Storage Configurations for Apple G5 PCI

This section describes qualified and recommended PCI slot configurations for the following Apple G5 
PCI systems:

• Apple G5 PCI

• Apple G5 PCI with Magma 64-bit 7-slot expansion chassis and PCI host card

• Apple G5 PCI with Digidesign Expansion|HD chassis and PCI host card

Apple G5 PCI

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Digidesign Expansion|HD Host PCIe card

CPU Slot 3 Optional: SCSI PCIe card or FireWire PCIe card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe card, FireWire PCIe card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 HD Core card

CPU Slot 3 Optional: HD Accel or HD Process card

CPU Slot 4 (133MHz 64-bit) Optional: PCI SCSI HBA, FireWire card, or Intel Pro/1000MT
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Apple G5 PCI with Magma 64-bit 7-Slot Expansion Chassis and PCI Host Card

Apple G5 PCI with Digidesign Expansion|HD Chassis and PCI Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Magma 7 Slot 64-Bit Chassis PCI card

CPU Slot 3 Optional: SCSI PCI card or FireWire PCI card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCI card, FireWire PCI card, or Intel Pro/1000MT 
PCI card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Digidesign Expansion|HD Host PCI card 

CPU Slot 3 Optional: SCSI PCI card or FireWire PCI card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCI card, FireWire PCI card, or PCI Intel 
Pro/1000MT

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Local Storage Configurations for Apple G5 PCIe

This section describes qualified and recommended PCIe slot configurations for the following Apple 
G5 PCIe systems:

• Apple G5 PCIe

• Apple G5 PCIe with Magma 64-bit 7-slot expansion chassis and PCIe host card

• Apple G5 PCIe with Digidesign Expansion|HD chassis and PCIe host card

Apple G5 PCIe

Apple G5 PCIe with Magma 64-bit 7-Slot Expansion Chassis and PCIe 
Host Card

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 HD Core card

CPU Slot 3 Optional: HD Accel or HD Process card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe or FireWire PCIe card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Magma 7 Slot 64-Bit Chassis PCIe card

CPU Slot 3 Optional: SCSI PCIe or FireWire PCIe card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe or FireWire PCIe card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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Apple G5 PCIe with Digidesign Expansion|HD Chassis and PCIe Host Card

Slot orders in the chassis run from left (closest to the power supply) to right.

Slot Card

CPU Slot 1 (AGP) Monitor card

CPU Slot 2 Digidesign Expansion|HD Host PCIe card 

CPU Slot 3 Optional: SCSI PCIe or FireWire PCIe card

CPU Slot 4 (133MHz 64-bit) Optional: SCSI PCIe or FireWire PCIe card

Chassis Slot 1 (closest to power supply) HD Core card

Chassis Slots 2–7 Optional: HD Accel or HD Process cards (6 maximum)
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appendix c

Video Buffer Underrun Errors
This appendix describes the three different types 
of video buffer underrun errors in Pro Tools 
with an Avid video peripheral. 

The Video Engine (“DIO Video Engine”) can en-
counter three different types of buffer underrun 
errors. 

“Video playback stopped due to a disk fifo 
buffer underrun.”

Indicates a disk buffer underrun in which data 
could not be read from the hard drive fast 
enough to play video.

“Video playback stopped due to a software 
decompression buffer underrun.”

Indicates a software decompression buffer un-
derrun in which there weren’t enough CPU cy-
cles to decompress video fast enough to main-
tain play back. 

“Video playback stopped due to a hardware or 
driver buffer underrun.”

Indicates a low level software buffer underrun in 
which the hardware or low level software could 
not keep up with the system load and needed to 
duplicate frames at the video output.

Visit http://answerbase.digidesign.com to 
search for possible solutions for any of these 
errors.
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